Gradework 1.12 Version Notes

New file format. This version is not backwards compatible with older versions of Gradework
and Earthwork 4D.

e Changed default file standard from ESW to ESX when saving documents for desktop products, thus
eliminating the need to write ESZ file type as a save format. Removed ability to save ESW files. ESX
files contain all of the data, including image files required to maintain the job, and are already in a form
suitable for sharing. ESW and ESZ files may still be opened. Default included images are "Used
Images". Other options are "No Images", "Current Image", or "All Images". This may be changed by
either selecting "Save As" from the File menu, or from the Options menu when no job is opened.

e Improved background image quality when printing from Layout View.
e Disables "Insert Point" in popup menu on Point Review List, if nothing is selected.

e Fixed inclusion of strata layers in XLSX volume report, when exporting to XLSX from ESW file saved with
volume calculation.

e Added upload to Access for larger ESX files when using File/email, instead of always adding it as an
attachment to emails generated. The threshold is currently set to 15 MB or larger.

o Added Default Fill Factor to the Options Menu which, when adding new Report Regions, is used to
initialize the fill factor field on the Add New Region Dialog. If enabled, applies to Job Site Region
created in 3D View/Planview when pressing "A" button.

e Registry settings are now stored in a file instead of the registry. Conversion occurs upon installation.
After installation, the old registry settings are left alone.

o Added ability to Export KMZ files from all of the Gradework Modes. If Gradework is not in Planview
Mode, the program will be put in Planview Mode, and then the export proceeds.

e Reports Fill Compaction Ratio on Volume Report and XLSX Export on subtotals only if all values being
subtotaled have the same value. Reports Cut Compaction Ratio for subtotals always.

e Added basic support for International Feet, in addition to US Survey Feet and Meters to various dialogs,
and to storage of the above units, as well as an EPSG code (if any) within the ESX file format.

e Fixed inability to send background image with cut-fill values, with cut-fill colors turned off, to the Print
Page from Planview.

Materials/Underground

o Added the ability to use commas in structure names, material names, pipes, symbols, classes, verticals,
groups and/or material codes, as CSV files written/read now allow use of the comma character.

o When starting a new job or importing a Structure List, the Code table is now populated with all
Structures and Materials that were in the Structures list with the code field empty, if they are not
found.

e Materials report exports to XLSX now always start report headers in column B.

¢ UG: When copying/renaming a vertical in the Edit Structure Dialog, copies and/or renames vertical into
master vertical list.



Gradework 1.11 Version Notes

This version is not backwards compatible with older versions

Added ability to import CAD files in which can be in a coordinate system (such as in state
plane) and draw the data near enough to the job (such as in local coordinates) to allow
aligning the data within the "Job Boundary" to that of the data within the "Site Boundary", or
vice-versa.

Added ability to assign colors/patterns to Report Regions, Sectional Areas, and Stripping
Areas.

Added new fields "Group", "Pattern”, "Color", and "Code" to Add/Edit Regions dialog - used
for adding and editing Report Regions, Sectional Areas, and Stripping Areas.

Volume Report is now grouped by new field "Group", which may be edited in the new Region
Edit/Entry Dialog. Works as before with older ESW files.

Groups and Codes may be enabled/disabled on the Volume Report from the Report View
menu.

Added "Select Within" to Edit Mode/Edit Menu, to select from any visible layer those lines
which are inside the given selected line(s) of another.

XLSX export of Volume Reports allow numerous new fields to be sent with XLSX output,
suitable for database import; added Database Export checkbox on Volume Report XLSX
Options Dialog.

Added ability to add codes for Strata layers.

Added "Confirm Surfaces" to Option Menu of all modes, to allow user to confirm or choose
anew Reference or Difference Surface, when going to 3D View, Planview, or Profile View -
tasks which could previously take too long to wait for before another pair of surfaces could
be chosen. Preference is saved to the registry.

Made Citrl-S the hotkey for "Save" (ESW file). Changed hotkey for "Swap Ends" from Ctrl-S to
Ctrl-R.

Fixed benchmark update upon applying Crop Rectangle on a geo-referenced CAD file.

User may now use the quote character (") in the Sectional/Stripping Depth field of the Edit
Regions Dialog for depth entry instead of having to enter tenths of a foot, if desired. For
example, entering 4" (4 inches) would do the math andfill in .333 as the section depth.

Fixed warning for maximum number of user defined surfaces to trigger at 32, not 31
surfaces.

Changes current Edit Layer to Benchmarks, when importing 2-point KMZ file.
Added ability to open/import 12d (.12da and 12daz) files.
Added IFC export



e Updated PDF reader.
e Improved File Merge to support up to 32 maximum number of user defined surfaces better.

o Fixed KMZ and ADF image output for jobs that use the same image name and page number
on several locations on the job.

¢ Revised"Change per 0.1 Ft./M" calculation to better reflect the available fill area in a given
region.

e Constrains entered Strata Cut Compaction values on Strata Names Dialog to arange of 0.0
to 2.0, and Fill Factor on Region Entry Dialog to arange of 0.1 to 2.0.

Materials & Underground
o Allowed Verticals to be F6 snapped anywhere along to pipes/laterals.

e Added F9function in Materials Entry Mode to grab the Invert, and optionally the Rim Elevation
from an entered pipe, if Assign Rim Elevations is not enabled.

e Added Phase Regions to Existing Layers pulldown, if phase region was created.
e Fixed Label Selection for hidden phases in multiple phase jobs.

o Made "View Depth Brackets with Strata" option display pipes on the plan view display in the
color of the strata layer it may enter.

e Added underground materials to Edit Codes Dialog.

¢ Calculates the average depth of pipes in one or more layers of strata for each strata surface
to the invert of the pipe. Any length of pipe that is above a given strata will display in the
Above column, if shown.

e Removed ability to Apply Trenches or Apply Structures to Existing or Design surfaces.

¢ Fixed Entry Mode snap to allow snapping near the intended vertex, as Gradework in Entry
Mode snap does, which helps snapping verticals to a desired pipe, when multiple pipes
with different invert elevations are located very close together.

o Fixeddisplay of solid filled "Count" symbols and added a couple of new ones.
o Fixed deletion of symbols which have "Master" unchecked in Edit Symbols Dialog.
o Fixed ability to delete extra materials added to pipes (if more than the first five).

o Fixed strata calculation in Underground Report when two or more strata layers have been
given the same name.

e When importing more than one page from a multi-page PDF file when in Materials Mode,
returns to Materials Mode.

o Phase Region tool only transfers classes/structures if not hidden.



Changed "Start Cover" default from "Invert" to "Pipe O.D." when entering a new pipe in the
Trench Description Dialog.

Version 1.10

Added Shrink Wrap functionality for perimeters, etc., to Utility Menu in Edit Mode.
Added ability to display Slope Colors on terrain, sorted by slope ranges.
Added new Slope Boundaries functionality.

Added ability to change corner types on offset lines running exterior to selected lines from
rounded to "squared",i.e., simply extrapolated to the intersection point.

Replaced "All" radio button in Profile Mode with View Layer List to allow control of what
layers shall be displayed with the reference and difference layers in the profile view.

Image Selection Dialog now allows multiple rows to be shown or hidden. Right click mouse in
grid to "Select All", or use Shift+pick or Ctrl+pick to set or clear a row selection, then click on
"Show" for any of the selected rows to change state for all rows.

Made F7 (reposition point) work with snap enabled; repositions selected point to nearest
point or segment found within the snap radius.

Fixed repositioning of selected points with Report Regions and Sectional Areas, such that if a
point is moved with F7 in one layer, the matching one moves with it.

Added "default labels", from CAD Modeling Colorsfile, to line labels in Line/Point Edit Dialog
and Entry Mode Dialog Bar.

Added AGTEK Community to the Help Menu.

Selects north/east ordering based upon language found. Still may use menu item "Display
Easting-Northing" to override value selected.

Modified the CSV writer (of site data) to write a header to the first line of output, describing
what order the data s in. It will write "Point Number,Northing,Easting" or "Point
Number,Easting,Northing" - depending on whether to switch northing easting order per the
locale setting, or it being overridden. Therefore, the reader has been modified to allow for
reading this header. If the order cannot be determined, the user will be prompted to let the
application know what order the data is in.

Added "Hide" menu option to Edit Mode Popup Menu and Materials Edit Mode Popup Menu.

Application now offers to copy the reference perimeter (plus 10 feet/3.048 meters of offset)
to the difference perimeter layer, if no difference perimeter exists when doing a volume or
balance area calculation.

Generalized Over-Ex Guide to support more applications.

Added Stockpile Guide.



Made default Edit layer Existing Lines, instead of Existing Perimeter, when starting a new job.
Added Add, Rename, and Reassign buttons to Manage Export Layers Dialog.

Allow user to modify Elevation, Depth, or Thickness on Strata Bore Log Dialog.

Fixed Export TP3/TN3 to work better when including surfaces in output file.

Fixed fill pattern display when changing the name of a region to one that already exists.

Materials

Added ability to change the current materials line label in Materials Entry Mode, by allowing
the user to use the "L" hotkey to modify the label to be applied to the newly added
structure(s). Changing to a different structure clears the current materials line label. Also,
clearing it through the Materials Edit Dialog in Materials Entry Mode causes the default label
behavior to resume.

MAT: Offset Line function in Materials Mode applies result of structures or data lines to the
Design Annotation Layer.

Saves report column state with ESW file.

Underground

Added ability to change the current materials line label in Materials Entry Mode, by allowing
the user to use the "L" hotkey to modify the label to be applied to the newly added
structure(s). Changing to a different structure clears the current materials line label. Also,
clearing it through the Materials Edit Dialog in Materials Entry Mode causes the default label
behavior to resume.

Fixed grouping of subtotals for multiple surfaces in the Underground and Trench Volume
reports.

Fixed swapping of pipe sections, when swapping ends of pipes.

Added Underground Entry Guide.

Highway

Refined wheel zoom increment on Mass Haul Diagram View.

Version 1.09

Allows selecting from PDF images as well from Image Selection Dialog, if image not found.
Changed LandXML reader to handle non-English filenames.
Fixed problem in Conform Selected Data Lines, when selected lines have arcs.

Fixed backspace behavior when entering scale points for "Attach Profile", as well as for Trace
Cross Sections" Mode.

Made TP3 writer more robust.



Fixed inadvertently going into double snap mode when snapping a pipe to the same pipe
two or more times with different pipes.

UG: Added Display/Underground option to view pipes and vertical conflicts in 3D.
UG: Added ability to set a "Station Offset" for pipes.

UG: Added ability to see pipes in 3D in depth bracket colors, with Depth Bracket display
enabled.

UG: Implemented Apply Trenches.

With Image Selection Dialog running, deselects image selections when picking lines from
layers not in Background Images layer.

MAT/UG: Added ability to display Materials Labels on Materials Reports, along with printing
them onreports

UG: Also sends Vertical (Structure) labels to Print Page, when "All Labels" selected.

UG: Fixed merging of materials labels when merging an ESW file with materials or
underground data.

MAT: Added Apply Structures to Surface functionality.

TW: Fixed Cycle Worksheet appearance on Print Page.

Version 1.08

Made Scale Factor independant of Elevation Scale in Import Units Dialog in CAD Import
Mode, when selecting "User Defined".

Added Topcon TP3 import/export capability.

MAT: Prevents comma character from being used for structure or material names, phases,
classes, symbol names, or codes.

UG: Added ability to make custom depth bracket ranges and colors for reporting and KMZ
export.

UG: Added ability to handle elliptical pipes.

UG: Added Pipe Length attribute to Trench Description Dialog, and drawing will have tick
marks along pipe at specified interval if non-zero. Tick mark starting point may be changed
to opposite end of pipe by swapping ends on it.

Added Cut to go with Copy and Paste in Gradework Edit Mode (not Materials Edit Mode). It will
remove data from the source, when pasted into a new layer. Escape key will forgo lines
selected for deletion.

HWY: Added ability to jump to any page of a multiple page PDF or TIFF from when in Cross
Section Entry Mode.



UG: Fixed distance mouse must move to clear rim-invert displayed in Entry Mode, when
entering laterals in metric files.

Improved ability to prevent entry of identical perimeters on top of a perimeters in Entry
Mode, Import Mode, and Copy/Paste functionality.

Fixed TP3 and LN3 readers to use grey line color when either white lines or black lines are
encountered.

UG: Fixed ability for user to edit vertical rim and/or invertin the Rim-Invert edit control.
Clears line snap count (for double snap), when deleting anything.

UG: Fixed display of evaluated invert value in Entry Mode with percent slope typed, when
snapping to a pipe.

Version 1.07

Added Background Images layer to the bottom of the Layer List, which is now used instead
of the various Annotation layers, and is now 'the' layer used to hold image rectangles. Added
"Image Selection" to the various Utility menus.

Added Image Layer non-modal window which allows the following capabilities
= Allows renaming of images to descriptive user names.
= Supports creating an image background of cut-fill maps from the planview.
= Allows deletion of animage from one location.

Imported CAD files now have text labels drawn with correct placement (rotation, size, word-
wrap, etc.).

Improved LAS\XYZ Choose Sample Rate Dialog with higher sampling rates available
Added Excel Custom Export for reports
Language support for Spanish, German, French, and Swedish

Whole line selection is now shown with bright white, and partial selection is bright white
within range selected.

KMZ Export outputs user defined image names, when over-ridden.

Ensures that if "Continue" is chosen in Entry Mode, that the next point entered is not an
entered (i.e., white) point, unless new elevation is typed by user first.

Fixed F6 snap to arc to use position along curve for newly added point.
Reduced first zoom level magnification using mouse wheel.

Added Background Images as layer that can be exported from CAD Export Dialog.



Fixed problem conforming stringless alignment to surface, when there are two or more
concurrent arcs in a given alignment.

Draws on-screen text in the same color as a given line when its line color is overridden.

Fixed number format issue in XLS output, and avoided outputting summary line for strata
data.

Interpolates elevations of "feature lines" read from CAD files.
Ensures that Terrain is turned off when opening a different file from 3D View.
Fixed creation of ESZ files, when adding a tif file(s) with extension "tiff".

Changed Layer view dialog to be non-modal and remain visible while interacting with data.

Materials/Underground

Added ability to enter and present Structure and/or Materials Codes on Report Dialog.

Calculates correct bedding/cover when box pipe thickness places pipe at the bottom of the
trench.

Fixed ability to vectorize a pdf in CAD Import Mode, then trim vectorized data in annotation
layer from Materials Edit Mode.

Added ability to import a structures.csv file with possible duplicates and incorporate only
unique structures (by Name and Class).

Fixed KMZ Export of 2D materials classes, particularly when the standard 2D class is not
first in the class list.

Hides pipes and laterals from structure pulldown, if Hide Lengths selected on toolbar.
Similarly, hides verticals and fittings if Hide Counts selected.

Fixed problem snapping pipes with rim-invert to annotation lines in Entry Mode.

If Fill to Grade checked and dialog dismissed, greys out Backfill Compaction in Trench
Description Dialog upon editing again.

Preserves fill factor on Report Regions when selecting the same area(s) for Apply Structures
to Sectional Areas as Apply Structures to Stripping Areas.

Highway

Fixed potential NAN bug when surfacing alignments that start in a curve.

Fixed accumulation of points in surfaces, when surfacing highway alignments repeatedly
without first deleting models.

Fixed Insert Curve if COGO selected is at start or end; fixed undo when taking it back out.

Version 1.06



Added "Brush" balance area drawing tool to Plan View toolbar.

Fixed problem when caching images when image in different job has the same name, but in
fact is different, by incorporating image size in the cache name.

Added checkbox to allow "Do not prompt again” for F12 ("Discrete Distance/Angle" Mode);
added message on status bar: "Press Q to Quit Discrete Distance/Angle Mode".

Added "Create Stringless Alignment" to Utility Menu, which uses curve data as read from
CAD files, to generate alignments containing straights and curves.

Volume Report now allows selecting subtotals only for Report Regions, Sectional Areas,
and Stripping Areas independently.

Fixed tiff reader to correctly update geo reference information, if user elects to put job in
state plane coordinates, the user's locale is in international feet, and the job is saved in US
survey feet, or vice versa.

Fixed inability to enter perimeter, after Balance Calculation warning that calculation cannot
proceed without entering perimeter.

Fixed problem assigning (first) strata surface to pipes in Pipe Lines layer, when exporting to
Materials 4D.

Fixed setting of points at break line (F5, Ctrl-X) to have "entered" attribute.

Added a checkbox to New Surface Dialog, to allow saving color selected as default color for
subsequent surfaces added.

Fixed assigning elevation from certain intersections problem with "Conform to Data Lines".

Materials

Fixed Phase Region Tool to no longer phase structures that are hidden.
Added ability to load images from image rectangles of any annotation layers shown.

Added ability to send selected areas to either Sectional Areas, Report Regions, or both,
from Apply Structures to Sectional Areas Dialog.

New structure name defaults to that of (the last) line selected, when creating a new
structure with one or more lines selected.

Can use selected area(s) as Phase Region(s), thereby avoiding needing to trace them in Entry
Mode. Behaves normally if nothing selected, or user declines to use selected area(s).
Default phase name taken from (the last) selected area.

User may enter inches for materials "Section”, in the form of 13.5", which becomes 1.125
feet, etc.



Made "Annotate" button in Materials mode more consistent. First click turns off all
Earthwork Layers. Second click restores annotation of current reference layer. Third click
turns off annotation layer again, etc.

Underground

Allows user to pick one or more pipes, then choose Assign Rim Elevations in Materials Edit
Mode, and then prompts user to use either "Selected Pipes", or apply to "Whole Job". If
nothing is selected, performs Assign Rim Elevations on whole job as before.

Updates Avg Depth when assigning rim elevations to selected pipe in Edit Mode.
Fixed interpretation of pipe size, when pipe name includes a hyphon and a number.
Changed default for strata checkbox on Assign Rim Elevations Dialog to off.

Fixed reporting of Total Average Depth on Depth Bracket Report for verticals.

Highway

"Homes" view upon importing LandXML file with horizontal COGO.

Disallows the following characters from being included in alignment names: < (less than), >
(greater than), : (colon), " (double quote), / (forward slash), \ (backslash), | (vertical bar or
pipe), ? (question mark), and * (asterisk), because they are not permitted as part of valid file
names.

Version 1.05

Added underground capability to Gradework.
Allows TIFF images to be imported from different directory(s) than current job read from.
Fixed LAS reader to handle LAS files stored in International Feet.

Inserts image rectangles on ALL user defined surfaces, even when user has no "Highway
Key".

Reduced size of exported DXF files by removing unused/unreferenced thumbnail image.

Fixed sparse contours produced from drone data, broken due to speed-up of routine used
to handle these large data sets.

Changed Entry Mode Options pull-down to read "Modeling Options" instead of "Status Bar
Display".

Can now import 32-bit JPGs or BMPs as well to the Print Page.
Region Selection Dialog now includes ability to select whetherto "Zoom to Selection".

Default directory for the File Import Dialog returns the previous directory of the last
successful file import for all supported file types.

Support for Australian GENIO file format.



Tiff images are reduced in overall file size, thus making ESZ files much smaller, when output
file compression can be improved over input file compression technique.

CAD reader handles AECCDbSurfaceContourLabeling entities better.

Ensures that "Job Site" encloses Report Regions that are double snapped to the Proposed
Perimeter.

Clears any selected line and/or point label when going into Entry Mode.

Eliminated flat contours in contouring algorithm which are not closed, or where there is no
appreciable area.

Added "Upload to ConX" checkbox to LandXML Export Dialog.

Preserves line label last used in Entry Mode, unless Surface or Layer changed after entering
data with line label.

Fixed Black/White Background color of CAD Import mode, to start in user's saved
preference.

KMZ: Handles very long/wide jobs map better in Google Earth with better lat/long
approximation for each coordinate.

Maintains hidden line attribute in Staged Design for Existing or Design data, if hidden before
going to 3D View Mode.

Topcon LN3 writer can now output multiple lines of text, when text lines are separated with
\P character sequence.

Limits number of layers (from Manage Export Colors) to actual number used in LN3 export.
Increased maximum number of user-defined surfaces to 32.
Fixed rectangle selection onimporting CAD files with more than a hundred layers.

Single line selected and modified with a negative value in the Line Editor Dialog changes
elevations relative to their old values.

Added ability to also change color of Strata as well as user defined surfaces in Manage
Surfaces Dialog.

Line thickness overrides now visible in KMZ output.

KMZ Exporter can now deal with single point profile lines, by skipping over them.

Materials

Updates label of Phase Region with name of phase region that data is being assigned to.

Any column picked on the Class (other than the Underground checkbox) or Phase Dialog
will make that class/phase current.



Backs up Structures(F/M).csv, Materials(F/M).csv, and Symbols.csv with a copy with the
extension ".bak" when overwriting.

Added F9 shortcut key to Materials Edit Mode, to allow sending selected data to to current
structure.

Only permits deletion of "Annotation”, "Pipe Lines", "Benchmarks", and "Phase Regions"
from Materials Edit Mode.

Implemented "Reassign Structure”, utilizing method of either double clicking on structure,
or selecting from Edit Structure button on status bar, and choosing different one on
Structure List of same type, then clicking OK.

Highway

"Approximate Horizontal Cogo"improved to better match arcs generated to tangents in and
out.

Surfacing Highway with Arc Controls displayed now places "Arc Controls" in the Highway
Data Layer.

Send to Highway now requires a minimum of two points for approximating horizontal or
vertical COGO.

Handles writing and reading sparse cross sections at stations generated by Station
Generator, where the Profile Line starts or ends outside of the surface's Proposed Perimeter.

If job has alignments and is written as an ESWfile, the file is made incompatible with
readers prior to GW 1.04.3.

Range selection in Station List Box updates viewport better on horizontal and vertical COGO
to allow seeing what is selected.

Added "Hide", "Show", and "Hide All But" for selected highway alignments in Horizontal
Cogo View.

Changed Edit Mode Utility Menu to read "Send to COGQO" instead of "Send to Highway".

Version 1.04

Support for integrated Materials program when key is present

Inserts image rectangles on ALL user defined surfaces, even when user has no "Highway
Keyll-

KMZ Exporter can now deal with single point profile lines, by skipping over them.

Fixed issue with entering more than one line, in "Discrete Distance/Angle" Entry Mode
method.

Made "Output By Line Label" the default when exporting CAD and iCON DXF files.

Changed wording of "Trace Template" to "Sketch Template" on New Template Dialog.



Fixed DXF/DWG export to Trimble Business Center.
Fixed display of Note/3D Note icons.

Fixed display colors of all layers, including those hidden during DXF/DWG export, when
"Output by Line Label" chosen.

Ensures that the elevation chosen for "Continue Line" is that of the last point on the
selected line.

Fixed problem with exporting some Earthwork 3D compatible files.
Increased final resolution of down-sampled TIFF images from drones.
Fixed import of highway alignments from AutoCAD files.

Fixed labels on ground control point export to use point label if available, line label if not,
and otherwise leaves empty.

Fixed problem with applying adjacent sectional areas, under sparse data conditions.
No longer imports volume report from ESW file that is "imported".
Prompts to save file, if Modify Export Colors has been modified.

CAD layer colors are preserved in ESW file, when importing from DWG/DXF file, so that
when exporting with "Output by Line Label", the original CAD colors may be kept.

When reading TTM or TN3 files, allows contouring by a user specified interval, whether to
smooth the contouring or not, or send triangles directly to Design Data layer.

Fixed inability to export images to KMZ file with overlapping bounding rectangles.
Sped up the reading of Poly-Face Mesh entities (corridors) from DWG/DXF files.

Context sensitive help now uses online help if connected with the Internet - local help
otherwise.

"Daylight" points inside of Sectional Areas/Stripping Areas are made "Entered", to disable
them from tracking elevation changes to the Existing Surface.

KMZ: checks ESW file path for "#" character, which is not allowed by Google Earth. User may
write KMZ file to another directory.

Fixed inability to select polyline (end cap) at the beginning of a line for which atemplate was
applied to.

Selects points/lines within trim regions when "Trim Only" is selected, even when no
intersections are found.

Volume Report now outputs subtotals only for Stripping/Sectional Areas, if chosen.



Contour lines sent from Import Mode to an annotation layer, and then have elevation
entered in Edit Mode, have will now have the first point marked as "entered", and all
subsequent points marked "interpolated".

Fixed "Continue" in Entry Mode, to display and use both the line label and elevation from the
previously picked line from Edit Mode.

No longer resets horizontal scale when transferring profiles to Print Preview.

Region Selection dialog no longer automatically zooms to location of picked region. To
permit zooming as before, hold either shift or control key while picking an element from
dialog.

Sped up transfer of CAD lines to Sitework layers when importing very large datasets
partially.

Add Benchmark Dialog now defaults to "W" instead of "E" for longitude, when adding new
benchmark.

No longer automatically turns on display of all layers to calculate "home view", when all
layers are disabled from rendering. Calculates job extent without requiring any layers to be
shown.

Fixed problem with keeping second point from being compressed out during offset line
operation.

Fixed several issues regarding importing JPG/JJGW Orthomosaic files through Drone Guide.
CAD reader now rejects any TIN surfaces that are outside of model space.

Added British National Grid for United Kingdom to Map Projection Settings Dialog.

Fixed interaction between "Plus Marks", "Plus Marks All", and F2 key.

LAS data read using "Dynamic" option may be re-written as LAS file, while preserving
"Support" label, if read back using "Original" option.

Fixed alignment parsing from LandXML files generated by Trimble.
HW: Added "Station/Offset" option back to the 3D View Display Menu.

Default "Vehicle Speed" has been setto 10, verses 3; override in 3D View/Edit/Vehicle Arrow
Rate.

Default Snap Size to 3, verses 4; override in Edit Mode/Options/Snap Size.

Default CAD Import background color changed to black; override in CAD
Mode/Display/White Background.

Added "Darken Image" option to Display Menu for various modes that support background
images. When reading TIFF images, Darken Image is automatically turned off. For PDF
background images, Darken Image is turned on. The "M" key still toggles this state.



Added "Manage Image Cache" to Edit/Entry Utility Menus.

Added "Display Easting-Northing" to the Main Menu (where "U.S. Highway Stationing"
resides).

Test for closed regions added to "Planview" and "Profile View" modes.

Import Mode and Edit Mode no longer "Home" the view when mode switching between
them.

Allows transferring triangle meshes through Import Mode to a given surface multiple times.
The user is no longer asked whether to contour triangle mesh, andis no longer warned
about replacing a triangle mesh. To contour final result, choose "Contour Surface" from Edit
Mode.

Added a right mouse menu to tree control to allow deletion by menu option.

ADF writer modified to reduce larger image sizes to accommodate mobile devices.
Allows entering Existing Perimeter from Drone Guide, if Existing surface is current.
Fixed printing hatch patterns with/without background image from Print View to BullZip.

Added prompt when Print Page contains objects and user is starting a new job, as is already
done when opening a different file.

Made two additional tabs (upper right and lower left) available for sizing objects on Print
Page.

Increased decimal degrees display precision to 8 digits (strip zeros still allowed) for
Benchmark lat/long display.

Increased Shade Increment maximum to 50 for foot jobs, 20 for metric on Shade Increment
Dialog.

Fixed KMZ image export to restrict image sizes for geo-referenced images, etc., to 8192
pixels maximum per image.

Fixed Image Cache Size limit to exceed 2 GB, if desired.

Allow TIFF images to be imported from different directory(s) than current job read from.

Version 1.03

Added Support for ConX to the "Leica Icon" machine control file option and KMZ exports.
Checks for update occurs on startup.

Added Guides for Drone processing and Vector PDF while renaming PDF Guide to "Entry
PDF Guide"

Added ability to move both background images/orthos with point cloud data through the
Utility-Transform Job-Align matching edges with the "Image and Selected Lines" option.



Outputs "geo-reference" info to ADF file whether Benchmarks checked or not.

EPSG Codes from anywhere may be typed in State Plane Lookup Dialog when a valid
benchmark is selected, and the site may be moved accordingly.

Extracts missing contours packed in regions in certain civil DWG files.
KMZ: Honors visibility flag for Profile and Highway Lines.
Reads .JPW/.JGW world file with .JPG image if found.

Prompts user to choose whetherto put geo-referenced TIFF/LAS files in state plane
coordinates, or leave in "job coordinates", when a discrepancy is found.

Fixed problem supporting geo-referenced jobs done in feet, for states such as Alabama,
which only unit of measure supported is meters.

Changed "Net Cut" or "Compacted Fill" column headers to push buttons, so that pressing
one or the other on the Progress Report Dialog, informs which columns get totalled for
"Cumulative Progress" and "Percent Complete".

Opening PDF changes current guide to Vector PDF Guide if vectorizable, Entry PDF Guide
otherwise.

Added Trace Template prompt, along with choice to Scale Template, to alleviate need to
scale templates for which free-hand drawing is adequate.

Version 1.02

Implemented new Export popup menu, so that all exportable file types are easily
recognized; "Save As" is strictly used for writing ESW and ESZ files now.

Added visibility controls and selective PDF sheet inclusion and visibility to KMZ export

ADF Export (mobile files for SmartDirt & SmartGrade) dialog now has look and feel of KMZ
Export Dialog, which also allows image selection along with layer/image visibility.

Revamped CAD exports

Added ground control point export functions for 3D Robotics, Drone Deploy, Photo-
Modeler, and Pix 4D.

Surface drop down lists display surface color along side surface names.

Added label for "support points" (kept at 5 foot intervals) when "Dynamic" point interval
chosen for point sampling method for LAS and XYZ file reads to aid in hiding them during
point cleanup.

Added "Move Site" to State Plane Lookup Dialog to allow changing of job to state plane
coordinates. The job must have at least two benchmarks with latitudes and longitudes, and
one of them must be picked.



e State Plane Lookup Dialog can now display/allow entry of latitude and longitude in
degrees/minutes/seconds, as well as decimal degrees.

¢ Point Edit Dialog can also display/allow entry of latitude and longitude in
degrees/minutes/seconds, as well as decimal degrees.

o Fixed "transparent” boundary of tiff images, when going from Edit Mode to 3D View and
back.

e Added New Zealand and World Zones to Map Projection Dialog. Also, EPSG code may be
typedinto EPSG Code field if it is known.

e Stopped automatically showing hidden annotation lines after trim operation.

¢ Improved CAD reader from crashing on several entity types which are rarely used for
earthwork.

e Made Export CAD, ADF, XML, and KMZ dialogs sizable.
e 64-bit versions of software no longer prompt "Would you like to try a network key ?"

¢ When importing orthomosaic TIFF images, uses bounding rectangle, if that is all that is
found in georeference block, to size and place image.

e Optimizes triangle meshes for Leica Icon export, when checkbox checked.

e Added "Do not prompt again" functionality to AutoPad Offset Dialog. To regain ability to
change offset after checking checkbox, save job and reopen it.

¢ Added ability to scroll contents of Layer Select Dialog, when hovering mouse over it and
rolling mouse wheel. Zooms view as before when mouse is not over it.

o Fixed ability to use CAD files specified in us-ft with TIFF and LAS files that are from states for
which there is no state plane coordinate system defined in feet.

o Allows writing ADF files without two benchmarks with latitudes and longitudes, with
warning.

e Fixed trim line function to suppress single points accumulated when trim line itself starts or
ends on data line.

o Improved performance of LAS reader, particularly for "Dynamic" spacing of resulting point
cloud.

e Random LandXML import colors are better selected to work with either black or white
backgrounds.

Version 1.01
e Excludes converting georeference of tiff files which are saved in oblique Mercator.

e Added "Dynamic" point sampling to LAS and XYZ readers.



Added "State Plane Lookup" function under "Utility/Transform Job" menu.

UTM based LAS files are now automatically transformed to a state plane coordinates.

Version 1.0

Fixed screen flash when editing elevation on single polyline in Edit Mode with H20 Vectors
enabled.

Labels points generated from contour surface routine with "Local Min" or "Local Max", as
applicable. Non-integral elevation flat lines are labeled "Flat Line". All other contours remain
labeled "Contour Line".

Added ability to read large geo-referenced orthomosaic TIFF files. 64-bit software
recommended.

Modified CAD Elevation Threshold Dialog to show Maximum on top, and Minimum below it.
Allows NEZ text files to be read with or without line numbers.

Added ability to read shape files (*.shp, *.shx) to support Lidar data.

Sped up reading of very large CSV files.

LAS and XYZ file readers allow reading files at "Original”, 3, 5, and 10 foot intervals.

Leaves Contour Lines visible for the given surface that they are generated from, when
changing current surface or layer. They are easily turned off for the given surface using Layer
Selection Dialog.

LAS and XYZ down-sampled points are positioned half an interval to the right and down,
since they are representative of an area centered by this new position.

ESZ, KMZ, and ADF writers include reduced tiff images when available.

Fixed display of radio list box buttons on displays that are set higher than 100%.
Made "TIFF" files open as "TIF"files.

Added ability to write XYZ and LAS files from GradeWork 4D.

Contour routine now finds "local minimums and maximums", wherever contouring used
from within the application.



